Microsoft Office Tips for Accounting Professionals

[image: image54.png]


[image: image55.png]



Microsoft® Office System
Tips for Accounting Professionals
Maximize your productivity with the Microsoft Office System, including:

· Microsoft® Office Excel® 2003

· Microsoft® Office Small Business Accounting 2006
· Microsoft® Office Outlook® 2003 with Business Contact Manager Update
Published: June 2005 

[image: image56.jpg]



© 2005 Microsoft Corporation. All rights reserved.

Information in this document is subject to change without notice. The example companies, organizations, products, domain names, e-mail addresses, logos, people, places, and events depicted herein are fictitious. No association with any real company, organization, product, domain name, email address, logo, person, places, or events is intended or should be inferred. 
This white paper is for informational purposes only. MICROSOFT MAKES NO WARRANTIES, EXPRESS OR IMPLIED, IN THIS DOCUMENT.

Microsoft, Excel, the Office logo, Outlook, and PivotTable are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.
Other product and company names herein may be the trademarks of their respective owners.

Contents

4Introduction


5Improve Productivity with Excel


5Fluidly Analyze Data with PivotTable Reports


5Create a Basic PivotTable Report


9Create More Complex PivotTable Reports


12Use What-If Scenarios to Project Future Values


15Use Excel to Compare Two Lists of Data


21Quickly Crunch Data in Small Business Accounting


21Improve Data Analysis with ‘Secret’ Tools


22Quickly Analyze Sales Data with PivotTable Reports


27Extend Outlook to Help Improve Client Relationships and Billing


28Get Started with Outlook 2003 with Business Contact Manager Update


29Consolidate Business Information in One View


30Track and Submit Billable Time


32Share Client Contact Information and Financial Data


34Additional Resources




Introduction
From analyzing financial data to communicating with clients, accounting professionals rely on the Microsoft® Office System to help them run their practice. Though you have probably developed common workflows and tasks you regularly use Office programs for, there are a number of lesser-known features and capabilities that can help you be even more productive at work. And maximizing your productivity can translate into higher efficiencies, better performance, and more satisfied clients.
This white paper provides tips and examples to help accounting professionals get the most out of Microsoft® Office Excel® 2003, Microsoft® Office Small Business Accounting 2006, and Microsoft® Office Outlook® 2003 with Business Contact Manager Update. Though many accountants will be familiar with at least a few of these tips, the topics are broad enough that there should be something new for most readers.
Tips for Excel:

· Analyzing data with Excel PivotTable® reports
· Using what-if scenarios to project future values
· Comparing two lists of data

Tips for Small Business Accounting:
· Using built-in data analysis tools, including PivotTable reports

Tips for Outlook 2003 with Business Contact Manager Update:

· Getting started with Business Contact Manager Update
· Tracking and submitting billable time

· Sharing client contact information and financial data with co-workers

Note: Throughout this white paper, the steps and illustrations used to explain features are taken from Microsoft Office 2003 programs and Small Business Accounting 2006. Earlier Microsoft Office programs sometimes provide similar functionality and tools, though the precise steps and the interface for features are different. Please refer to the Help menu of your Office program if you need assistance working with features mentioned in this white paper using earlier versions of Office software. 

This document is provided to accounting professionals as part of Microsoft’s commitment to the accounting community. We value your comments and feedback and look forward to serving you. Please visit http://www.microsoft.com/accountants for more information.
Improve Productivity with Excel
Because of its powerful number crunching capabilities, many accounting professionals spend more time in Microsoft® Office Excel® than in any other Office program. Knowing the software well enables you to save time and provide better analysis and advice to clients. Though you are probably as familiar with Excel as with your office chair, there are several powerful features and capabilities that you may not know about that can help you more quickly analyze large amounts of data, project future values, and compare lists of similar items. 
Fluidly Analyze Data with PivotTable Reports

Of all the analytical features built into Microsoft Office Excel, PivotTable® reports are one of the most powerful, and there are many Excel users who don’t take advantage of the feature. For accounting professionals, and anyone else who routinely works with large amounts of data, they can help you analyze data more quickly and more intelligently.
Imagine an Excel worksheet of sales figures for a client’s company with hundreds—no, thousands—of rows of data. Everyone has questions about what the data means. How do you get the answers? PivotTable reports organize and summarize data so that it doesn't just sit on a worksheet in an overwhelming format. PivotTable reports offer comparisons, reveal patterns and relationships, and analyze trends. Because they can be “customized,” PivotTable reports enable you to display different views of data, turning data into information that makes sense.

Create a Basic PivotTable Report
There are three steps to creating a PivotTable report:

1. Ask questions.

2. Use the PivotTable wizard.

3. Create the PivotTable report.

Imagine that Excel is open and you're looking at sales figures. 
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Sales figures that go on and on
In this example, there are 799 rows of sales listed by country, salesperson, and order amount. 

How can you make the data more understandable? To find out, you begin by asking yourself what you need to know. In this example, let’s assume you want an answer to the following question: How much has each salesperson sold?
Once you’ve formulated your questions, you’re ready to start the wizard. To start the PivotTable wizard, click anywhere in the data, and then click PivotTable and PivotChart Report on the Data menu.
After the wizard opens, click Finish. That's it. You could spend more time with the wizard, but in this example it's not necessary. Clicking Finish tells the wizard to use its default settings. By default, the wizard will:

· Use data in an Excel list or in a database. 

· Prepare a layout area for creating a PivotTable report. 

· Use all the data on the list. 

· Place the report layout area on a new worksheet. 
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Click Finish in the PivotTable and PivotChart Wizard to use default settings.
The wizard takes only a few moments to prepare a new worksheet with everything you need to create a PivotTable view of your data: the PivotTable Field List to drag items from, the layout area to drag items onto, and the PivotTable toolbar.
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Note: If the PivotTable toolbar is not visible, on the View menu, point to Toolbars, then click PivotTable.

In the PivotTable Field List are the names of the columns from the source data (the sales figures): Country, Salesperson, Order Amount, Order Date, and OrderID. Each column in the source data has become a field with the same name. You create a PivotTable view of your data by dragging fields from the field list and dropping them onto the layout area.
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  Column headings on the worksheet...
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  ...become fields on the field list.
The layout area is divided into separate outlined drop areas onto which you drag and drop fields from the field list. The layout area becomes your PivotTable report.
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  Row Fields displays data vertically, one item per row.
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  Column Fields displays data horizontally, one item in each column.
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  Page Fields displays data as pages, grouping or separating items in the data you put here.
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  Data Items is where numerical data is shown and summarized.
Labels on the drop areas tell you where to drop data to display it in a specific orientation. If you were to drag the Salesperson field into the area labeled Drop Row Fields Here, for example, you would see one row for each salesperson's name. If you dragged the Salesperson field into the area labeled Drop Column Fields Here, you would see one column for each salesperson's name.

Now it's time to put the pieces together. Remember the question you want to answer: How much has each salesperson sold? To find out the answer, you use two of the fields on the field list: the Salesperson field to display the names of the salespeople, and the Order Amount field to display the amount that each person sold. To display each salesperson's name on its own row, drag the Salesperson field to the drop area labeled Drop Row Fields Here. To see the sales amount for each person, drag the Order Amount field into the area labeled Drop Data Items Here. The Data Items drop area is where you usually drop data containing numbers, because Excel automatically adds up numbers in this area. The totals then appear in your PivotTable report. When you drop the Order Amount field into the data drop area, the colored outline disappears, and you see the report view.
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  Drag the Salesperson field onto the layout area for rows to display each salesperson's name on one row apiece.
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  Then drag the Order Amount field to the Drop Data Items Here layout area to see the sales amounts for each salesperson.
The PivotTable report summarizes 799 rows of information so that you can see at a glance how much each salesperson sold. You can use the information any way you want to: show the report to others, copy it into a Word document, or publish it to a Web page.
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The PivotTable report summarizes 799 rows of information.

To get the answers to other questions as quickly and easily, you could drag other field items onto the layout. Or, to display different relationships, you could sort or pivot your data with different fields in the columns or rows simply by dragging field items from one drop area to the other.
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Create More Complex PivotTable Reports
Beyond the basics, PivotTable reports provide a number of features to help you quickly crunch data and present it in visually compelling ways.
Use the Sort and Top 10 Feature

In many instances, it makes sense to present information in specific ways. For example, if you were preparing a report summarizing sales figures by salesperson, it would be useful to list the names by the amount sold instead of alphabetically. That way your client could see at a glance who is performing the best. Also, it is often useful to present only the top results. For instance, it might be useful to present data on only the top 10 customers to a client to isolate the most important information or present it more clearly.

PivotTable reports provide a built-in tool to accomplish both of these tasks. 
Sorting starts by clicking PivotTable on the PivotTable toolbar, and then selecting Sort and Top 10.
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PivotTable Sort and Top 10 dialog box
From the PivotTable Sort and Top 10 dialog box you can choose to sort items by ascending or descending value and you can choose to show only the top or bottom five, or any other number you like. Because the underlying data isn’t affected by how you choose to sort the report, if you decide later on that you need to change the sort order, you can do so via the same dialog box without having to retrieve the data again.
Change How the Data is Summarized

PivotTable reports are useful because they quickly summarize data. In the earlier example, a report summarized sales data to enable you to quickly see the dollar value of sales by salesperson. However, sum is just one of the ways that PivotTable reports can summarize numerical data. To change the way the data is summarized, you would click any cell in the data area, click the Field Settings button [image: image16.png]


on the PivotTable toolbar, and then make a selection from the Summarize by list to count, or find the average, or find the maximum or minimum, or any of various other possibilities.
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PivotTable Field dialog box
Use Grouping to View Less Detailed Summaries

Another way to control how data is summarized is to control the level of detail presented. This often comes in handy when working with data that includes dates. For instance, if you’re working with sales numbers for 2004 that are presented by day, you can quickly change the presentation to sales by quarter.
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Sales by day for 2004

To group sales by quarter, you would right-click the date field, point to Group and Show Detail, click Group, and then select Quarters. 
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The Grouping dialog box
The result is a new view that presents sales by quarter.
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Sales by quarter for 2004

Use a Custom Calculation
PivotTable reports offer you the flexibility to control the calculations performed on data to change how it is presented. For instance, instead of choosing to simply present a sum of sales by quarter, you could choose to break the sales down into percent of yearly sales per quarter. 

To use a custom calculation, click the Field Settings button [image: image21.png]


on the PivotTable toolbar. In the Summarize by list, make sure the summary function is Sum, because you want to see the percentage of the sum of the yearly sales per quarter. Then click Options in the PivotTable Field dialog box, and in the Show data as list, select % of total.
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Selecting % of total in the PivotTable Field dialog box

The result shows the percentage of sales per quarter.

[image: image23.png]Sum of Sales |

Customer Date [~ Total
Pro Sporting Goods Qut | 7381%)
an2 857%

w3 | 12.86%
atrd 4.76%)





Percentage of sales per quarter
Format PivotTable Reports
Once you’re through pivoting, sorting, and arranging a report to contain just the information you want, you can easily format it to make it easier to read and turn it into a professional-looking document that you can share with a client.
To format a report, click the report, click the Format Report button [image: image24.png]


on the PivotTable toolbar, and then select one of the PivotTable formats in the AutoFormat dialog box.
Excel 2003 offers more than 20 different automatic formatting options for you to choose from.
Use What-If Scenarios to Project Future Values

For many accounting professionals, projecting future values, such as cash flow or sales revenue, is an important part of working with clients. Creating accurate projections helps clients make better decisions and enhances your role as a trusted advisor. 
In creating projections, it's often helpful to project more than one set of values to find out how they affect your results. You can do this easily with what-if scenarios—sets of input values that Excel 2003 can substitute automatically in your worksheet.

What-if scenarios can help you answer questions your clients might have, such as:
· How would changing my variable cost per unit affect my net profit? 

· What would my estimated capital gain tax liability be if I sold certain investments? 

· How would my loan payments change if I found a lower interest rate? 

You can create and save different scenarios on a worksheet and then switch between scenarios to view different results. You can also create a summary or PivotTable list with the results of all your scenarios.

Try It with a Breakeven Analysis

To do a breakeven analysis and find out how changing the variable cost, fixed cost, unit sales, or price will affect your client’s profit, you can define different values for these variables and then switch between scenarios to compare the results.

The following illustration shows the current breakeven analysis for this example.
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Breakeven analysis: Current scenario

Create scenarios

1. On the Tools menu in Excel, click Scenarios. 

2. Click Add. 

3. In the Scenario name box, type a name for the scenario. 

4. In the Changing cells box, enter the references for the cells that you want to change, or hold down CTRL and click each cell. 

In this example, to try a scenario of a lower price and projected higher unit sales, hold down CTRL, and then click cells B2 and B3.

Note  To preserve the original values for the changing cells, create a scenario that uses the original cell values before you create scenarios that change the values.

5. Under Protection, select the options you want, and then click OK. 

6. In the Scenario Values dialog box, type the values you want for the changing cells. For example, for $B$2 (price per unit), type 6.25. For $B$3 (unit sales), type 110000. 

7. To create the scenario, click OK. 

8. If you want to create more scenarios, click Add again, and then repeat the procedure. When you finish creating scenarios, click OK, and then click Close in the Scenario Manager dialog box.
Display a scenario

1. On the Tools menu, click Scenarios. 

2. Select the scenario you want to display, and then click Show. 

The values for the scenario are automatically substituted in your worksheet.
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Breakeven analysis: Higher price scenario

Create a scenario summary report or PivotTable report

1. On the Tools menu, click Scenarios. 

2. Click Summary. 

3. Click Scenario summary or Scenario PivotTable. 

4. In the Result cells box, enter the references to the cells you want to display in your report—generally cells whose values are changed by the scenarios. In this case, enter B6:B8 to find out how the scenarios affect total costs, total revenue, and profit. 

Note  You don't have to specify result cells to generate a scenario summary report, but you must specify them for a scenario PivotTable report.
The scenario summary report displays the variables for each scenario and the result cells.
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Scenario summary report
The PivotTable report displays the result cells for each scenario. You can use the drop-down arrows to choose the results you want to be displayed. In this example, even though total revenue is lower if you raise the price, profit is higher. But if you lower the price, total revenue is higher and profit is lower.
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Scenario PivotTable report

You can try other scenarios and find out how they affect net profit. For example, what if the variable unit cost rises by 25 cents per unit, but price per unit stays the same? By using scenarios, you can create as many scenarios as you need to help clients plan their business strategy.
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Use Excel to Compare Two Lists of Data
For financial record keeping, you often have to compare two lists to find data that appears on one but not on the other. Which new clients need to be added to the master database? Which credit card receipts are not reflected on the monthly statement, and vice versa? What checks and deposits are still outstanding? It's a tedious task if you do it manually. 

Microsoft Office Excel 2003 can help you perform this task faster and more accurately. In many cases, you can do it even if the data is not provided in a standardized form in both lists.

Comparing Two Lists of Assets

For instance, say you have two lists of assets—the fixed asset records for a company and a property tax affidavit that must be updated annually. 

If you would like to follow along on your computer, you can download the Compare Two Lists sample datasheet directly from Microsoft Office Online by linking to:                                                    http://office.microsoft.com/en-us/templates/TC011117371033.aspx.

	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 

	 
	Property Tax Affidavit
	
	Fixed Asset Records
	 

	 
	Category
Code
	Acquisition
Year
	Description
	Cost
	
	Asset No.
	Asset
	Date
Acquired
	 Cost 
	 

	 
	490
	1997 
	Printer
	2,025 
	
	1563126
	Printer
	06/01/97
	2,025 
	 

	 
	357
	1998 
	Press
	11,000 
	
	1563190
	Press
	07/02/98
	11,000 
	 

	 
	130
	1998 
	Copier
	1,575 
	
	1578084
	Copier
	07/31/98
	1,575 
	 

	 
	130
	1999 
	Copier
	1,299 
	
	1584122
	Copier
	12/28/99
	1,199 
	 

	 
	490
	2001 
	Printer
	825 
	
	1584161
	Printer
	06/01/01
	825 
	 

	 
	490
	2002 
	Copier
	1,231 
	
	1587023
	Copier
	11/07/02
	1,231 
	 

	 
	490
	2002 
	Printer
	1,788 
	
	1587038
	Printer
	02/20/02
	1,788 
	 

	 
	610
	2002 
	Computer
	17,090 
	
	1587182
	Computer
	03/04/02
	17,090 
	 

	 
	610
	1996 
	Computer
	15,275 
	
	1587916
	Lift
	03/05/02
	15,464 
	 

	 
	130
	2002 
	Copier
	1,577 
	
	1587922
	Vacuum
	09/15/03
	359 
	 

	 
	
	
	
	
	
	1594236
	Press
	12/27/03
	6,900 
	 

	 
	
	
	
	
	
	1596732
	Copier
	01/05/04
	799 
	 

	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 


Business assets on property tax affidavit and on fixed asset records
Updating the property tax affidavit is a five-step process:
1. Make sure each asset has a unique identifier. 

2. Find assets on the property tax affidavit that are not in the fixed asset records. 

3. Find assets in the fixed asset records that are not on the property tax affidavit. 

4. Sort lists to see nonmatching assets more easily. 

5. Review nonmatching assets and check for accuracy. 

Step 1: Make sure each asset has a unique identifier

The following illustration shows the property lists in an Excel spreadsheet.
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Property tax affidavit and fixed asset records in an Excel spreadsheet

As you see, the property tax affidavit does not have unique identifiers, such as asset numbers, for each asset. But to compare these lists, assets in each one must have a unique identifier. In this example, the best way to identify each asset is by a combination of asset description and date, so you would add a new column called "Description & Date" to each list. 
Add a "Description & Date" column to the fixed asset records

1. In the Fixed Asset Records area of the worksheet, select the Asset column, and then on the Insert menu, click Columns. 

2. In cell G2, type Description & Date, and then press ENTER. 

3. Select cell G2. On the Format menu, click Cells, click the Alignment tab, select Wrap text, and then click OK. 

4. In cell G3, type =H3&" "&YEAR(I3). This combines the description from cell H3 and the year from cell I3 into one field. 

5. To copy the formula from cell G3 to cell G14, select cell G3 and then drag the fill handle [image: image30.png]


 to cell G14. 

6. To make the column width fit the results, double-click the boundary to the right of the Description & Date column heading. 
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Fixed asset records with combined description and date in new column
Add a "Description & Date" column to the property tax affidavit

1. In the Property Tax Affidavit area of the worksheet, select the column to the right of the Cost column, and then on the Insert menu, click Columns. 

2. In cell E2, type Description & Date, and then press ENTER. 

3. Select cell E2. On the Format menu, click Cells, click the Alignment tab, select Wrap text, and then click OK. 

4. In cell E3, type =C3&" "&B3. 

5. To copy the formula from cell E3 to cell E12, select cell E3, and then drag the fill handle [image: image32.png]


 to cell E12. 

6. To make the column width fit the results, double-click the boundary to the right of the Description & Date column heading. 
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Property tax affidavit with combined description and date in new column
Now that you're comparing apples to apples, you can get down to business.

Step 2: Find assets on the property tax affidavit that are not in the fixed asset records

1. In the Property Tax Affidavit worksheet, select the column to the right of the Description & Date column, and then on the Insert menu, click Columns. 

2. In cell F2, type Missing?. 

3. In cell F3, type =ISNA(MATCH(E3,$I$3:$I$14,FALSE)). 

4. To copy the formula from cell F3 to cell F12, select cell F3, and then drag the fill handle [image: image34.png]


 to cell F12. 

Assets that are on the property tax affidavit but not in the fixed asset records will display TRUE in the Missing? column.
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New Missing? column showing whether an asset is not found in the other list

Step 3: Find assets in the fixed asset records that are not on the property tax affidavit

1. In the Fixed Asset Records worksheet, in cell M2, type Missing? 

2. In cell M3, type =ISNA(MATCH(I3,$E$3:$E$12,FALSE)), and then press ENTER. 

3. To copy the formula from cell M3 to cell M14, Select cell M3, and then drag the fill handle [image: image36.png]


 to cell M14. 

Assets that are in the fixed asset records but not on the property tax affidavit will display TRUE in the Missing? column.

Step 4: Sort lists to see nonmatching assets more easily

To more easily see the assets that are not on both lists, you can sort the lists.

Note  If you sort the lists without first following these steps to convert the formulas to values, the formulas will not calculate correctly. In a large database, converting the formulas to values can also help avoid long recalculation times.

Sort for nonmatching assets in the Property Tax Affidavit worksheet

1. Drag the pointer to select cells A2 to F12. 

2. On the Edit menu, click Copy. 

3. On the Edit menu, click Paste Special. 

4. In the Paste Special dialog box, under Paste, click Values, and then click OK. 

5. On the Data menu, click Sort. 

6. Under My data range has, click Header row; in the Sort by box, click Missing?, and then click OK. 

Sort for nonmatching assets in the Fixed Asset Records worksheet

1. Drag the pointer to select cells H2 to M14. 

2. On the Edit menu, click Copy. 

3. On the Edit menu, click Paste Special. 

4. In the Paste Special dialog box, under Paste, click Values, and then click OK. 

5. On the Data menu, click Sort. 

6. Under My data range has, click Header row; in the Sort by box, click Missing?, and then click OK. 

You can now easily see which assets may need to be added or deleted to update the property tax affidavit.
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Property tax affidavit and fixed asset records sorted by Missing? column
Step 5: Review nonmatching assets and check for accuracy

Before you update the property tax affidavit, it's a good idea to manually review the nonmatching assets—which is fortunately a lot faster than manually comparing the entire list. Review the nonmatching assets and determine why they don't match. Were the assets retired or sold? Are they new assets that should be added, or are they assets that are not required to be reported on the affidavit? Or did the assets fail to find a match because of misspellings or other errors?

Other ways to prepare data for matching

Sometimes the data in two lists must be standardized before Excel can compare the lists. In the preceding example, the dates in one list were converted to years, and two fields were combined into one. The following table shows common data inconsistencies and suggested Excel functions that you can use to prepare data for matching. 

	Problem
	Example
	How to modify

	Inconsistent abbreviations
	Litware, Inc. vs. Litware, Incorporated
	Use the LEFT function to create a field with only the number of characters from the left that you specify.

	Extra numbers or characters on one list
	12345 vs. 12345-1033
	Use the LEFT or RIGHT functions to create a field with only the number of characters from the left or right that you specify.

	Imprecise numbers caused by estimates, rounding variances, or sales tax
	$12,000 vs. $12,011
	Use the ROUND function to create a field with comparable amounts.

	Extra spaces
	Jae B. Pak vs. Jae   B. Pak
	Use the TRIM function to remove all spaces from text except single spaces between words.
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Quickly Crunch Data in Small Business Accounting
Microsoft® Office Small Business Accounting 2006 is a comprehensive financial management program designed for small businesses with fewer than 25 employees. The most recent addition to the Microsoft® Office System, many accounting professionals are probably less familiar with Small Business Accounting than with other Office programs. The application provides sales, purchasing, inventory, banking, and payroll functionality. In addition, Small Business Accounting provides several extremely powerful tools that allow you to work directly with the Small Business Accounting company database, enabling you to quickly analyze data and create reports.
Improve Data Analysis with ‘Secret’ Tools 
Small Business Accounting provides a number of powerful analysis tools that enable users with the appropriate Microsoft Office software to extend the accounting system by connecting to the Small Business Accounting company database and generating Microsoft® Office Excel® 2003 PivotTable® reports and Microsoft® Office Access 2003 database reports. (Generating Excel PivotTable reports using the analysis tools requires Excel 2003, and generating Access reports using the analysis tools requires Access 2003.) With these reports, you can make sense of your clients’ transactions by extracting meaningful information from the data. You can see comparisons, reveal patterns and relationships, and analyze trends. Then, you can prepare professional-looking reports to deliver to clients. 
The Analysis Tools dialog box provides you with two PivotTable report templates covering sales and purchases and eight Access reports. You can also create new PivotTable report templates in Excel or new reports in Access and add them to the list of available tools.
To open the Analysis Tools dialog box: on the Start menu, point to Programs, point to Microsoft Small Business Accounting, and then click Analysis Tools. 
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The Analysis Tools dialog box

To select a specific tool, click the name of the Excel PivotTable report template or Access Report you want to work with and then click Display, or double click the name of the tool. The tool will automatically open in the correct program. The Access and Excel reports link directly to the company database, so you can be sure you’re working with current data. 

Once you’ve gone through the process of creating a useful report that crunches, formats, and prepares the data in just the way you like, you can use it to analyze data from other Small Business Accounting company files. For instance, to reuse an Excel report, simply open up the PivotTable report you want to use and click Change Company. An Excel Macro enables you to connect to a different company database.
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The Change Company button in Excel
Quickly Analyze Sales Data with PivotTable Reports
Small Business Accounting 2006 makes it easy to analyze client data by including two Excel PivotTable report templates accessible through the Small Business Accounting Analysis Tools dialog box. The included templates are:
· Sales Analysis Excel PivotTable

· Purchase Analysis Excel PivotTable

To give you an understanding of the power of the included Excel PivotTable report templates, consider a hypothetical situation that is representative of the type of thing a small business might want to know. Say a hypothetical client, the fictitious Northwind Traders, approaches you in the beginning of 2006. 
Let’s say that Northwind Traders is a wholesaler of sporting goods that relies on five customers for most of its business. Its best customer, Pro Sporting Goods, has lately gotten into some financial trouble, so Northwind has decided to focus a new sales campaign on one of its remaining top four customers. Northwind tells you that they want to target the customer whose year-over-year sales growth has been the strongest. Using historical sales data, Northwind wants you to tell them which customer to target. How do you go about offering advice?

Small Business Accounting offers over 40 reports, but it doesn’t include one that gives year-over-year growth. You could use the program’s reporting functionality to generate sales by customer for 2004, export the numbers to Excel, and then repeat the process for the 2005 numbers and do some cutting and pasting and draft some formulas to create a spreadsheet that would give you the results you need. But you can perform the same task much more quickly using the Sales Analysis PivotTable report template. Even better, once you’ve customized the PivotTable report, you can save it and reuse it with the data from other clients tracked in Small Business Accounting, helping you to increase productivity.

Crunch Northwind Traders’ Sales Numbers

For this example, you want to examine Northwind Traders’ sales using the Sales Analysis Excel PivotTable template. 
Note: The following example is based on data in the Northwind Traders company file, which is included in Small Business Accounting as the product based sample company. If you’d like to follow along on your own computer, launch Small Business Accounting, click Open a sample company on the Start page, select Product based sample company, and click OK.

To open the Sales Analysis Excel PivotTable template:

1. Open the Analysis Tools dialog box: on the Start menu, point to Programs, point to Microsoft Small Business Accounting, and then click Analysis Tools. 
2. Click Open, select the company file you want to analyze, and click Open again. (If you’re following along on your own computer, choose the file named sampleproductcompany.sbc.) 

3. Select Sales Analysis Excel PivotTable. 
4. Click Display. 
The tool will connect to the company database and open in Excel.
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Sales numbers for Northwind Traders in the Sales Analysis PivotTable report
From your previous experiences with PivotTable reports, you will recognize the gray field headings and the PivotTable Toolbar. As well, you will notice the Small Business Accounting Report toolbar that includes a button that says Refresh Report. If the underlying data changed, you would click this button to update the PivotTable report with the new data. The Excel Workbook also contains two sheets, one named Sales Cube and the other named Sales Chart. As you might suspect, the Sales Cube sheet contains the PivotTable report and the Sales Chart sheet charts the PivotTable report. As you’ll see, this makes it easy to quickly create charts from your report.

The PivotTable report presents sales data by customer and year, so you already have the basic information you need to make your recommendation to Northwind Traders. However, if it didn’t, you could quickly change the presentation of data by dragging and dropping or removing fields to present the data in the way that best serves your interests. You could also do such things as changing how data is summarized to present sales by a different time period, such as quarterly or monthly.
Now that you have the data you need, you can clean it up to make it easier to work with. You don’t need to see contact information right now. 
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To hide customer contact information:

1. Right-click the Customer Name. 
2. Point to Group and Show Detail.

3. Click Hide Detail. 
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Also, Northwind is only interested in seeing data on four customers: the top five, minus Pro Sporting Goods, so you can go ahead and select only the necessary companies. Because the data is already presented in descending order by sales, you can easily see that you need to limit the report to:

· Global Sporting Goods
· Alpine Ski House
· Coho Sports
· Fitness Department Stores
To manually select the customers to display:

1. Click on the drop-down arrow beside Customer Name. 
2. Clear the (Show All) checkbox.

3. Manually check the boxes beside the four companies to display. 
4. Click OK.
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Selecting companies to display
Now, to make the data more readable, you can format the sales as currency rounded up to the nearest dollar. 
To format the numbers:

1. Click any cell in the data area.

2. Click the Field Settings button [image: image42.png]


on the PivotTable toolbar.
3. Click Number, select the currency format in the Format Cells dialog box, and click OK.
4. Click OK.
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Sales figures sorted and formatted
Now you’re almost done. You’ve sorted the data so you have just the sales figures you’re interested in, and you’ve formatted it so it’s easily readable. Now, to complete the table, it’s necessary to do some old-fashioned Excel formula work. Northwind Traders wants to know the year-over-year sales growth, so you can create a column titled “YOY Growth” to the right of the Grand Total column that calculates this. In the worksheet you’re working with, you’re interested in comparing columns C and D. The first row with sales data is row 10, so you can use the following formula for that row:

=((D10-C10)/C10)

To create a column that calculates year-over-year growth:

1. Select cell F10, type the formula =((D10-C10)/C10), and press ENTER.

2. Copy the formula into the remaining cells in the column by selecting cell F10 and then dragging the fill handle [image: image44.png]


 to cell F14. 
The formatting doesn’t match the rest of the table, so, for readability, you can change the font size and style of the new column to match the other columns. You can also change the border style so it matches. Finally, the YOY Growth is displayed in fractions. For ease of reading, you can change it to display as round percentages. After making these changes, you have a succinct report that clearly shows year-over-year growth.
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Report showing year-over-year sales growth

Now that you have a table that shows sales growth, it’s easy to offer advice. If Northwind Traders wants to target the customer with the fastest year-over-year sales growth, the company should focus on Fitness Department Stores, with a sales growth of 83%.
In addition, you can easily create a professional-looking report to send to Northwind Traders that includes the year-over-year growth report. And, because the Small Business Accounting PivotTable templates include both a chart and a report that are simultaneously updated as you make changes to them, a chart of the report is one click away, on the chart sheet. In our example, as we’ve been refining the PivotTable report, behind the scenes Excel has been making the same refinements to the PivotTable chart. To see the chart, simply click the Sales Chart sheet. Note that the chart includes only the PivotTable data, not the additional year-over-year growth calculations that were created in the column to the right of the PivotTable report. In this example, the PivotTable chart provides just the information Northwind Traders needs to be able to see at a glance the change in sales from 2004 to 2005 for its best customers.
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PivotTable chart showing sales in 2004 and 2005
Extend Outlook to Help Improve Client Relationships and Billing
In order to succeed, it’s important that accounting professionals stay on top of relationships with clients and accurately track their billable hours. While Microsoft® Office Outlook® 2003 offers a great way to manage e‑mail, appointments, and daily tasks, many accounting professionals don’t realize that Outlook 2003 also includes Business Contact Manager, powerful client relationship software. With the latest update, Microsoft Office Outlook 2003 with Business Contact Manager Update helps you track client opportunities, market your services, and manage your business relationships, and is designed to improve client service, which could result in fewer lost opportunities.
Note: Business Contact Manager Update for Microsoft Office Outlook 2003 provides the latest updates to Outlook 2003 with Business Contact Manager. Licensed users of Microsoft Office Small Business Edition 2003 or Microsoft Office Professional Edition 2003 are eligible to upgrade to Outlook 2003 with Business Contact Manager Update by downloading it or ordering a CD (shipping and handling charges apply). Visit the Outlook 2003 with Business Contact Manager Update site for more information at:

http://www.microsoft.com/office/outlook/contactmanager/prodinfo/update.mspx.
Outlook 2003 with Business Contact Manger Update integrates with Microsoft Office Small Business Accounting 2006. When combined with Small Business Accounting, the software becomes even more useful, drawing from the wealth of customer and financial data in the accounting program to include customer financial history and company cash flow as well as client contact and opportunity information in one place. In addition, integration enables you to mark appointments in the Outlook Calendar as billable time and submit it to Small Business Accounting, helping you prevent billable hours from slipping through the cracks.

Using Outlook 2003 with Business Contact Manager Update with Small Business Accounting, you can:

· Track accounts, business contacts, and opportunities. 

· Store all customer information in a single place. 

· Generate reports to prioritize your daily activities and better forecast revenue. 

· Link e-mail messages to records, helping you to centralize communications. 

· Share business contact data among users. 

· Create quotes and invoices in Outlook.

· Import accounting data from Small Business Accounting. 

· Track billable time in Outlook and submit it to Small Business Accounting for billing.

· Synchronize business contacts with your Pocket PC.

Get Started with Outlook 2003 with Business Contact Manager Update
Outlook 2003 with Business Contact Manager Update is available in the following Office editions:

· Microsoft® Office Small Business Edition 2003
· Microsoft® Office Professional Edition 2003
· Microsoft® Office Professional Enterprise Edition 2003
· Microsoft® Office Small Business Management Edition 2006
If you’re running one of these editions, then you should be able to start using Outlook 2003 with Business Contact Manager Update right now. 
Note: Licensed users of Microsoft Office Small Business Edition 2003 or Microsoft Office Professional Edition 2003 are eligible to upgrade to Outlook 2003 with Business Contact Manager Update by downloading it or ordering a CD (shipping and handling charges apply). Visit the Outlook 2003 with Business Contact Manager Update site for more information at:

http://www.microsoft.com/office/outlook/contactmanager/prodinfo/update.mspx.
To enable Business Contact Manager Update: on the Start menu, point to Programs, point to Microsoft Office, point to Business Contact Manager for Outlook, and then click Enable Business Contact Manager for Outlook. 
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Enabling Business Contact Manager Update for Outlook 2003
Once you’ve enabled the program, you can connect your Outlook 2003 with Business Contact Manager Update database to Small Business Accounting. 
To connect the Outlook 2003 database to Small Business Accounting:

1. In Outlook, click the Business Tools menu.

2. Point to Accounting Tools and click Set Up Connection to Accounting.

3. Follow the directions in the Set Up Connection to Accounting dialog box to connect to your Small Business Accounting database.
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Consolidate Business Information in One View 

Once Outlook 2003 with Business Contact Manager Update has been integrated with Small Business Accounting, you can view clients’ financial history directly in Outlook. This makes it easy to quickly answer questions and improve client service.

Outlook 2003 with Business Contact Manager Update organizes client information into records called Accounts. Within each account, information is organized into four tabs: 
· General. Provides primary contact information and links to associated opportunities, tasks, appointments, phone logs, and other files.

· Details. Offers a place to provide notes about the account and how it was found. 
· Financial History. Once Business Contact Manager Update has been linked to Small Business Accounting, you can view a client’s complete financial history from the Financial History tab. You can double click any transaction to view the original record.
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The Financial History tab of Business Contact Manager Update
· Financial Summary. Once it has been linked to Small Business Accounting, you can click on the Financial Summary tab of Outlook 2003 with Business Contact Manager Update to view a summary of a client’s balance, sales, and credit information.
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The Financial Summary tab of Business Contact Manager Update
Track and Submit Billable Time
As accountants know, the easier it is to track billable time, the more accurately you will capture your billable hours, and the less revenue will slip through the cracks. Once you’ve connected your Outlook 2003 with Business Contact Manager Update database to Small Business Accounting 2006, you can easily mark appointments, phone logs, and tasks in Outlook as billable time and then transfer and record that information to Small Business Accounting with a few clicks, giving you an easy way to facilitate accurate, timely billing.

Outlook 2003 with Business Contact Manager Update provides several ways to create time entries from appointments, phone logs, and tasks, depending on whether you want to submit them one at a time or in a batch. For accountants and other professionals who rely heavily on billable hours and regularly invoice clients by time period, the batch feature helps you stay on top of billing by allowing you to submit time by the week or month. 

To submit several time entries at once, the appointments, phone logs, and tasks must be marked as billable. To mark a record as billable, simply click the Billable button in the Outlook Toolbar.
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Marking an appointment as billable

When you want to submit hours to Small Business Accounting, you can create time entries directly in Outlook, without even having to launch the accounting program. 
To submit multiple time entries:

1. Click the Business Tools menu in Outlook.

2. Point to Accounting Tools and click Submit Billable Time. 
3. Enter billing information into the Submit Billable Time dialog box. 
The Employee name, Bill To, and Billing Item fields are linked to Small Business Accounting, so you can choose items from drop-down boxes that will accurately categorize the items in the accounting software. If you’re using jobs, the Job Name field is also linked to the accounting program. Though the Actual field defaults to the duration specified in the Outlook item, you can manually enter the actual time you want to bill. You select the billing period by using the Look for drop-down box.

4. When you’re finished entering information into the dialog box, click Submit.

The billing information is accurately sent to Small Business Accounting and classified according to your specifications.
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The Submit Billable Time dialog box

Next time you use Small Business Accounting, these new billing items will appear as Time Entries and will be available for creating client invoices and for tracking employee hours for payroll.

Create Invoices in Outlook
Outlook 2003 with Business Contact Manager Update is flexible, allowing you to use it to fit your own workflow. For instance, after you’ve integrated Outlook 2003 with Business Contact Manager Update with Small Business Accounting 2006, if you want to invoice a client for a specific Outlook item, Business Contact Manager Update allows you to create an individual time entry directly from an appointment, phone log, or task. From the time entry, you can then create an invoice. You can do all of this from within Outlook without having to open Small Business Accounting. 
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Creating an invoice from within Outlook

Share Client Contact Information and Financial Data 

Service professionals who share clients will appreciate the ability to share their Outlook 2003 with Business Contact Manager Update database with co-workers. By working from a shared database, you can be sure that all employees are working from the same client information and that changes made by one employee are available to all.
Using Business Contact Manager Update for Outlook 2003, authorized employees can share client information, such as previous communications, recent orders, or financial information. Before you can share your Outlook 2003 with Business Contact Manager Update database, you must be an administrator on the computer where your database is stored. You may also need to grant users access to the computer where your Business Contact Manager Update database is stored. In sharing information, some care should be taken as sharing the database also allows co-workers who can view your Business Contact records to create, edit, or delete business contact information. 

To share your Outlook 2003 with Business Contact Manager Update database:

1. On the Business Tools menu, click Share Database. 

2. Click the I still want to share my Business Contact Manager data with other users option to indicate that you want to share your database with other users, then click Next. 

3. In the Select Users dialog box, select the names of users whom you want to grant database access to. Click Add User to browse for another user in your workgroup. Click Next. 
4. Follow the instructions in the Share Database wizard.
Note: Because e-mail messages can be shared accidentally and result in confidential information being distributed unintentionally, when the database status is changed to shared, e-mail addresses previously enabled for auto-linking are no longer enabled. Keep in mind that you must select any e-mail addresses that you want to enable for auto-linking after you share the database. 

Additional Resources

This white paper covers only a few of the many ways that you can better use the Microsoft Office System to help improve your productivity. For training, assistance, and more tips, visit Microsoft Office Online, where you will find a wealth of resources for accounting professionals.

Microsoft resources for accounting professionals:

Microsoft Accounting Professionals Home
http://www.microsoft.com/accountants
Microsoft Office Small Business Accounting 2006 Accountant White Paper 

Downloadable from the Microsoft Accounting Professionals Web site at:

http://www.microsoft.com/accountants
Microsoft Office Online Home
http://office.microsoft.com/en-us/default.aspx

Microsoft Office Online: Tools for Auditors and Accountants
http://office.microsoft.com/en-us/FX011387261033.aspx
Microsoft Office Online: Finance Professionals
http://office.microsoft.com/en-us/FX010931831033.aspx
Microsoft Office Online Training (requires Office 2003)
http://office.microsoft.com/en-us/training/default.aspx
Note: To access training materials, you must have one of the following editions of Office 2003 installed on your computer:
· Microsoft Office Professional Edition 2003

· Microsoft Office Small Business Edition 2003

· Microsoft Office Standard Edition 2003

· Microsoft Office Student and Teacher Edition 2003

Microsoft Office Online Assistance
http://office.microsoft.com/en-us/assistance/default.aspx
Setting up Outlook 2003 with Business Contact Manager Update to connect to Small Business Accounting





Clicking Hide Detail to hide customer contact information





History Items provides access to linked e�mails, phone logs, meetings, tasks, files, etc.





Tabs provide direct access to contact and financial information





A sample business account record in Outlook 2003 with Business Contact Manager Update





Portions of this section of the white paper were excerpted and adapted from “� HYPERLINK "http://office.microsoft.com/en-us/assistance/HA010864791033.aspx" ��Use What-If Scenarios to Project Future Values�,” located on the Microsoft Office Online Web site at: 


http://office.microsoft.com/en-us/assistance/HA010864791033.aspx.


For more Assistance resources, visit � HYPERLINK "http://office.microsoft.com/en-us/assistance/default.aspx" ��Microsoft Office Online Assistance� at http://office.microsoft.com/en-us/assistance/default.aspx.





Portions of this section of the white paper were excerpted and adapted from “� HYPERLINK "http://office.microsoft.com/training/training.aspx?AssetID=RC010136191033" ��PivotTable I: What's so great about PivotTable reports?�”, located on the Microsoft Office Online Training Web site (requires Office 2003) at: http://office.microsoft.com/training/training.aspx?AssetID=RC010136191033.


For more Training resources, visit � HYPERLINK "http://office.microsoft.com/en-us/training/default.aspx" ��Microsoft Office Online Training� (requires Office 2003) at: 


http://office.microsoft.com/en-us/training/default.aspx.


Note: to access training materials, you must have Microsoft Office Professional Edition 2003, Microsoft Office Small Business Edition 2003, Microsoft Office Standard Edition 2003, or Microsoft Office Student and Teacher Edition 2003 installed on your computer.








The PivotTable toolbar





� INCLUDEPICTURE "http://office.microsoft.com/training/images/callout1.gif" \* MERGEFORMATINET ���  PivotTable Field List to drag items from.


� INCLUDEPICTURE "http://office.microsoft.com/training/images/callout2.gif" \* MERGEFORMATINET ���  PivotTable layout area to drag items onto.





Portions of this section of the white paper were excerpted and adapted from “� HYPERLINK "http://office.microsoft.com/en-us/assistance/HA011039151033.aspx" ��Use Excel to Compare Two Lists of Data�,” located on the Microsoft Office Online Web site at: 


http://office.microsoft.com/en-us/assistance/HA011039151033.aspx.


For more Assistance resources, visit � HYPERLINK "http://office.microsoft.com/en-us/assistance/default.aspx" ��Microsoft Office Online Assistance� at http://office.microsoft.com/en-us/assistance/default.aspx.
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